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Overview

Potential pitfalls of SOA-only thinking.
Strategic Modeling patterns: DDD's “other half” and RESTful SOA

Tactical Modeling patterns: DDD building blocks and integration

Integrating Bounded Contexts: Making models work together
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SOa Pitfalls

Service concerns and responsibilities overload

* Services * Transactions
' Security * Domain Logic
* Data Access * Translation
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Ask-Decision-Sef
Tell-Don't-Ask



W

hat about business?

The business focus is on its domain

s your

husiness domain that of Service-Oriented Architecture?

We wan!

to do Jomain-Driven Design, not SOA-Driven Design



RESTtul SOA with DDD

Model based on the language of the business domain

Services based on resources that represent Model state/behavior
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DDD S’rru’regic Design

Suvuguml ?IJ A,

Strategic Modeling is nof reuIIy the “other half” of DDD

Strategic Modeling is the most widely applicable part of DDD



DDD Strategic Modeling

Bounded Context Open Published A“"'.
Context Map Host Language corruption
Service Layer

Important patterns for basic DDD and integration (BC and (M)
DDD is not about Entities, Value Objects, Repositories, etc.

DDD is about modeling the business domain in its own language _
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The delimited applicability of a particular model. Gives team
members a clear and shared understanding of what has to be
consistent and what can develop independently.
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ldentity & Access Context

/ Tenant User \

PersonChanged
RegistrationInvitation Person
UserPasswordChanged
TenantProvisioned ContactInformation
TenantRepository UserRepository

O Role

Group AuthenticationService
O RoleRepository
GroupMember EncryptionService
GroupRepository Identity and Access Schema
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Collaboration Context

/' Author

Creator

Moderator

Owner

Participant

Calendar

CalendarRepository

Forum

ForumRepository

ForumChanged \

DiscussionStarted

Discussion

RemovedPostFromDiscussion

Post

PostedToDiscussion

DiscussionRepository

Collaboration Schema

PostChanged

CalendarEntry

Invitee

Repetition

TimeSpan

CalendarEntryRepository

CalendarEntryScheduled

\Z

~/

12



Agile PM Context

ProductRepository ProductOwner TeamMember
Product
BacklogItemCommitted BacklogItem Release Sprint
BacklogItemScheduled Task ScheduledBacklogItem| | CommittedBacklogItem
BacklogItemStatusChanged EstimationLogEntry | | BusinessPriorityCalculator| |ProductReleaseScheduled
TaskStatusChanged ProductBacklogIltemPlanned | | ValueCostRiskRatings ProductSprintscheduled

E Agile PM Schema
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(ontext Map

Identity & Access Context

Collaboration Context

< <Published Language ==

< <Published Language ==

< <Published Language = »

< <Published Language = »

< <Published Language = »

.ﬁg#ile Project Managem
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UserResource NotificationResource ForumResource CalendarResource MotificationResource
R M A A2 A A
User | . | Role | Forum . Calendar
MemberTra nl's.lator e - { 1Synchron -Eelr
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s ent Context 5 L

< <Anticorruption Layer ==
MemberService

< <Anticorruption Layer ==
DiscussionService

< <Anticorruption Layer=>
SchedulingService

-
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ProductOwner

TeamMember

W

W

Discussion

ScheduledEvent




Open Host Service

Client
(app)

HTTP

Define a protocol that gives access to your subsystem as a set
of services. Open the protocol so that all who need to integrate

Resources as
Services

with you can use it.

RESTful

o
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Published Lunguuge

fen Model representation ™~
. DY choice... use case driven

@r oduces({"application/xm", "application/json"})

Use a well-documented shared language that can express the
necessary domain information as a common medium of
communication, franslating as necessary...
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Anticorruption Layer

Domain Model (BC)

Domain Service / i

Client (app) AcL

GET

<

>

Value Object | |

Create an isolating layer to provide clients with functionality in

terms of their own domain model

XML

RESTful

]
]
i

|
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DDD Tactical Design

Layered
Architecture

Aggregate
(uses Entity)

Value
Object

Domain
Event

Domain
Service

Building block patterns typically used in a DDD project

Support integration patterns of Strategic Design




Layered Architecture

OHS RESTful Services;

User Interface Layer —<— (and Presentation)

Security, transactions;

Application Layer  <+— Thin task coordinator

Domain Layer <«— |solated core model

~Technical capabilities;
persistence, messaging...

Infrastruciure Layer — <—
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Aggregate

< <Aggregate Root>>
Product

+backlogltems <<Entity>>

-descripti
escription BacklogItem

ame 0..*

+commitBacklogltemToSprint()
+getallBacklogltems()
+getalloutstandingBacklogItems() Telease
+getAlReleases() releases
+aetallSprints() < <Entity =
+getBacklogltem() 0..% Release
+aetRelease()

+getSprint()

+oetValueCostRiskTotals()
+planBacklogItem()
+regressCommittedBacklogltemPromSprint()
+regressScheduledBacklogItemFromRelease ) <<Entity>>
+removeQutstandingBacklogItem() 0. Sprint
+reprioritizeBacklogltem() " -sprint
+scheduleBacklogltemForRelease)
+scheduleRelease()
+scheduleSprint()

-=prints

Object composition cluster with consistency boundaries

Publishes Domain Events, which indicate significant occurrences



Value Object

_ ) 4 N
Identity & Access Context Collaboration Context

User Role Moderator

Describes something about an object in the domain model

Supports minimalism; concepts translated from other contexts




Domain Event History

SMALLIALK-80

E LANGHUASE AND TS DAPLEAENTATION

Adele Goldbesg and Dovid Rabsot

Publish notifications to Views when updates occur in the Model

Lero, one, or more updates may occur and View cannot assume



Domain Events Today

DomainEvent

-pccurredOn: Date
-subject: Object

. ettt S arameter: Object -
<<Domain Event>> | % I : %
TenantProvisioned d & D

.-"-
- -
-" -
- -
-
-
-
-
-

< <Domain Event>>

. R ; . u e < <Domain Event
TenantActivated R N I " . UserRegistered
<<Domain Event>= <<Domain Event>= : <<Domain Event>= <<Domain Event>=
TenantDeactivated PersonameChanged| ' | UserPasswordChanged| |UserEnablementChanged
<<Domain Event>>

PersonContactInformationChanged

A significant occurrence in the model; defined in past tense

Published largely by Aggregates as their states transition



Domain Service

CollaboratorService —
< <\alue Object»
Collaborator
+getAuthor aTenant: Tenant, anldentity: String): Author
tgetCreator(aTenant; Tenant, anldentity: Sting): Creator - 3 -emalAddress
+gethoderator (aTenant: Tenant, anldentity: String): Moderator {denity

+getQuner (aTenant: Tenant, anldentity: String): Qnner Tame
+getParticipant(zTenant: Tenant, anldentity: String): Particpant

When a significant process or transformation in the domain is not
a natural responsibility of an Entity or Value Object, add an oper-
ation to the model as a standalone interface declared as a Servicg.




1: POST

DDD + RESTful

User Interface

Application Domain Laver

Layer

ForumB.esource

Lavyer

2 : startForum()

3 1 respaonse

ForumService CollabaoratorService ForumRepositary
— 3 : getCreator() : E
4 : getModerator () I I
a:icicreateb::
'8 new() !
6 : add() I



Collab AcL + RESTful

Application Infrastructure Layer

Layer

User Interface Laver

ForumService

CollaboratorServiceImpl

1

: getModerator()

(Remote Service)

2 : toCollaborator()

& : moderator T

{{ ..............
S : moderator —

UserInRoleAdapter | | CollaboratorTranslator < <RESFful = >
UserResource
3 LGET
: =

4 : toCollaboratorFromCiocument ()

]



UserInRoleAdapter

GET https://iamtenants/{tenantld}/users/{usernane}/inRole/{role}
public Col | aborator toCollaborator(...) {

d i ent Request request =
t hi s. bui | dRequest (aTenant, anldentity, aRol eNane);

C i1 ent Response<String> response =
request.get(String.class);

| f (response.getStatus() == 200) {
col | aborator =
this.getTransl ator().toCol | aborator FronDocunent (
response. getEntity(),
aCol | abor at ord ass);
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GET .../inRole/{role}

@Pat h("/tenants/{tenant|d}/users")
public class UserResource {

@ET

@at h("{usernane}/inRole/{role}")

@roduces({ "application/xm" })

publ i ¢ Response get User | nRol g(
@at hParan("tenantld") String aTenantld,
@at hPar an{"usernane") String aUsernane,
@at hParan{"rol e") String aRol eNane) {

/] use Application Layer to interact wth Domai n Layer...
Response response = ...;
return response;
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HTTP GET User-In-Role

GET https://iamtenants/{tenantld}/users/{usernane}/inRol e/ {rol e}
Accept: application/xmn

HTTP/ 1.1 200 K
Cont ent - Type: application/xm

<user | nRol e>
<t enant | d>CCA701C2- 6490- 41B9- B4DA- DB785107C8C8</t enant | d>
<user name>j doe</ user nane>
<firstNanme>John</firstNanme>
<| ast Nanme>Doe</ | ast Nane>
<emai | Addr ess>John. Doe@onmai nnet hod. or g</ enai | Addr ess>
<r ol e>Mbder at or</rol e>

</ user | nRol e>
32



CoIIuboru’rorTrunsIu’ror

public Coll aborator toCollaboratorFronDocunent (

Docunent doc = this. buildDocunent (aUser | nRol eDocunent);

XPat h xpath = Xpat hFact ory. new nst ance() . newXPat h() ;

String usernane = xpath.evaluate("//usernane", doc, ...);
String firstName = xpath.evaluate("//firstName", doc, ...);
String |astNane = xpath.evaluate("//|astNane", doc, ...);

String emai |l Addr = xpath. eval uate("//emai | Address", doc,

Col | aborator coll aborator =
t hi s. newCol | abor at or (
usernane, firstNane, |astNanme, ennil Addr, aColl abType):

return col |l aborator:

)
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“Simple” Event:
Loe Doe
Gets Married

Service Capability: [&A self service allows Zoe to change name

Service Quality: Eventually names must reflect I&A Context



Problem?

<<Value Object>=

<<Value Object] Moderator -
Author —=value Object> =
Author
<<Value Object> <<Value Object>>
<<Value Object>>|  Creator Participant
ner <<Value Object>> < <Value Object>>
<<Value Object> > Owner Creator
Participant
Value Obi < <Value Object>>
] i

Collaborator Values are created new for each request (by choice)

Changes to users in the 1&A Context are not reflected in Collab _



Solution (HM not MOM)

<notifications tenant| d="C388F4B2- 71F0- 48D2- BAA3- 0A44BABFA2E1"
| d="55F03810- 09FF- 4925- BOFD- 7935CC91F31D" archi ved="fal se">
<notification type="personNaneChanged"
occurredOn="2010- 08-19T16: 38: 06- 06: 00"
| d=" A9D234C6- 96EF- 4B9A- BAC9- F720A2115B3B" >
<per sonNaneChanged>
<t enant | d>C888F4B2- 71F0- 48D2- B4A3- 0A44BABFA2E1</t enant | d>
<user nanme>zoe</ user nane>

«<Value Object==

<firstName>Zoe</firstName> <<Value Object|  Moderator P
Author | ralue 1 nect=x
<| ast Nane>Jones- Doe</ | ast Nane> Author |
/ Ch d < <Value Object= = <<Value Object >
</ per sonNameChanged> —evalue Obectas|  Creator Participant
</notification> Ovner _ <<Value Object>> <<Value Object>>
< <Value Object=> Owner Creator
Participant

</notifications>

val bi <<Value Object=>
<<Value Object=> Modarator

Moderator

Use shared Value Objects that are eventually consistent

Publish event-based nofifications out of each Bounded Context N



|&A Domain Events

Application Layer Domain Layer

IdentityService MotificationLogaer DomainEventPublisher s ser

1: subscribe() I

' 1]

+2 : changePersonalMame() :

3 : velidate()

ol
: J 4 : publish{)
g hani:IIEEﬁf'Entﬂ- i :

6 : log()




|&A Event Types

GroupGroupAdded

GroupGroupRemoved

GroupUserAdded

GroupUserRemoved

PersonContactinformationChanged RoleGroupAssigned
PersonNameChanged RoleGroupUnassigned
TenantActivated RoleUserAssigned
TenantDeactivated RoleUserUnassigned
TenantProvisioned

UserEnablementChanged

UserPasswordChanged

UserRegistered
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Agile PM Sychronization

Application Layer

Infrastructure Layer

User Interface Layer

(Remote Service)

MemberMaintenanceTimerMBean Integration

MemberServiceImpl

IdentityAccessMotificationsAdapter

< <RESTRUl ==
NotificationsResource

El:synchrnnizerﬂemhers“- E i
‘ IE:maintainrﬂemhers[ﬁ

' Ouil of band

(max-age based)

Updates cache

>D 3 synchrunizefﬂemhersﬂlh I

loop Memherl_li:ldater )

4 *[not completed] : GET
o

5 : updateMemberiame()

: updateMemberEmail&ddress])




Notification Logs

<<Aggregate Root> >
/-Nat@atinnlng
7 < «Value Object =
-archived: boolea Natification
notificationLogld: Btring
nextiotificationLggld: String -definition: String
-previoushotificgfonLogld: String et =S
- L Sirffig -occurredOn: Date )
+getAlNotifications() type: String
HogMotification()

+sArchived()

Series of logs from the beginning of time; NOT in Core Domain

Current working log and any number of archived logs



Notification Referencing

next next next
D — e —

CURRENT Noti fication Notification OLDEST
Notification Log Log Noti fication
Log Log
NOT _ARCHI VED ARCHI VED ARCHI VED ARCHI VED
— — —
previ ous previ ous previous

Navigate through previous logs to find latest applied nofification

Apply all newer notifications, navigating to current using next



Feeds

N

appl i cati on/ at omtxni appl i cation/ xn

Can produce Atom-based notifications from NotificationLogs

Can produce custom notifications from NotificationLogs
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NotificationResource (1)

@at h("/tenants/{tenantld}/notifications")
public class NotificationResource {

@ET
@r oduces({ "application/xm" }) A\ Cus’rom, current |Og

publ i ¢ Response getCurrentNotificationLog(
@at hParan("tenantl1d") String aTenantld,
@ontext Uilnfo aUrilnfo) {

NotificationLog currentNotificationLog =
this.getNotificationService()
.getCurrentNotificationLog(new Tenantld(aTenantld));

...
return tenpResponse;
}

RESTful notification service as a resource (OHS producing PL)



NotificationResource (2)

@ath("/tenants/{tenantld}/notifications")
public class NotificationResource {

@ath(*{notif )4
at notificationl =1 o :
Broducesct " amal i oation xm Specific log, next/previous

publ i c Response getNotificati onLog(
@at hParan("tenantl1d") String aTenantld,
@at hParan("notificationld") String aNotificationld,
@ontext Uilnfo aUrilnfo) {

NotificationLog notificationLog =
this.getNotificationService()
.getNotificationLog(
new Tenant | d(aTenantld), aNotificationld);

... \
return tenpResponse: May filter using parameter




HTTP GET Notifications

GET https://iamtenants/{tenantld}/notifications
Accept: application/xmn

HTTP/ 1.1 200 K
Cont ent - Type: application/xm
Link: <https://iamtenants/C888.../notifications>;

rel =sel f
Li nk: <https://iamtenants/ C888.../notifications/55F03810-...>;

rel =pr evi ous

<notifications ...>
<notification ...>
</notification>

</notifications> 45



HTTP GETting It All

HTTP/ 1.1 200 K
Cont ent - Type: application/xm
Link: <https://iamtenants/C888.../notifications/72G31419-...>;

rel =sel f
Link: <https://iamtenants/ C888.../notifications/46A0C283-...>;

rel =next
Li nk: <https://iamtenants/ C888.../notifications/55F03810-...>;

rel =pr evi ous
Cache- Control : max- age=3600

<notifications ...>

<notification 1 d="A9D234C6- 96EF- 4B9A- BACO- F720A2115B3B" >

</notification> ‘K\/

XSO * Track latest locally
</notifications>

46



Incoming Notification
Tracker

private I ncom ngNotificationTracker tracker;
[]...
private void applyNotification(... aNotification) {
[l ...
this.getTracker()
. recor dMbst Recent (
aNotification.getld(),
aNot i fication. get Type(),
aNotification.getCccurredOn());



Notification Element

<notification type="personNaneChanged"

occurredOn="2010-08-19T16: 38: 06- 06: 00"
| d=" A9D234C6- 96EF- 4B9A- BAC9- F720A2115B3B" >
enaat | d>

<per sonNaneChanged>
<t enant | d>C888F4B2- 71F0- 48D2- B4A3- 0A44BABFA2EL</t

<user nane>zoe</ user nane>

<tirstNamezoe</ firsthare> | Descending date/time order

<| ast Nane>Jones- Doe</ | ast Nane
</ per sonNaneChanged>
</notification>

Quter notification element contains common information

Child reflects Domain Event from originating Bounded Context



Agile PM Shared Values

Product Omer [ o -<¥ —

TeamVenber [

MemberService (Domain) caches single instance in database

Anticorruption Layer (notifications adapter) updates
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Zoe's New Name

Product Omer product Omer =
Domai nRegi stry
. get Menber Servi ce()
. get Product Oanner (tenant, "zoe");

assert Not Nul | ( product Owner) ;

assert Equal s(product Owmer. get Nane(),
"Zoe Jones- Doe");

assert Equal s(product Oaner. get Emai | Addr ess(),
"zoe@hi ftmet hod. cont') ;
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Autonomous Services

Notifications from Domain Events of all three Bounded Contexts
Notifications allow seeding Model from “beginning of time”

Notifications allow recovery from any service down-time
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Summary

For Business: combine RESTful SOA with Domain-Driven Design

Strategic Modeling patterns: DDD's “better half” for RESTful SOA

Tactical Modeling patterns: Domain Events key building block
[

Integrating Bounded Contexts: RESTful

Hypermec
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Contact

Vaughn Vernon
vvernon@shiftmethod.com

Questions?

Please fill out evaluation forms!
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